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Disclaimer
This document contains supporting material for the Inventory and Monitoring Toolbox, which
contains DOC’s biodiversity inventory and monitoring standards. It is being made available
to external groups and organisations to demonstrate current departmental best practice.
DOC has used its best endeavours to ensure the accuracy of the information at the date of
publication. As these standards have been prepared for the use of DOC staff, other users
may require authorisation or caveats may apply. Any use by members of the public is at
their own risk and DOC disclaims any liability that may arise from its use. For further
information, please email biodiversitymonitoring@doc.govt.nz
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Synopsis
Collecting data on reef fish abundance, diversity, and demographic attributes is an important
directive of environmental monitoring programmes, both within and outside New Zealand’s marine
protected areas (MPAs). Baited underwater video (BUV) is an unobtrusive sampling method which
is effective in providing size and abundance estimates of scavenger and carnivorous reef-fish
species that can be difficult to survey using divers (Willis & Babcock 2000; Harvey et al. 2004;
Shortis et al. 2009).
Within New Zealand, this technique was initially adopted by researchers at the University of
Auckland (Willis & Babcock 2000) to undertake snapper (Chrysophrys auratus) and blue cod
(Parapercis colias) size and abundance assessments as part of MPA surveys. This method was
primarily used as a response to counteract diver-positive and diver-negative biases for snapper
observed during earlier visual census surveys (Cole 1990, 1994).
Prior to conducting a BUV study, consideration should be given to identifying monitoring objectives
and the motives for these:


What species is the survey going to be primarily targeting?



What are the central hypotheses to be tested and do these satisfy the management/survey
objectives?



Statement of clear outcomes of the surveys relative to the original monitoring objectives.

A range of BUV systems are available and used in New Zealand (Willis et al. 2000; Willis &
Babcock 2000; Willis et al. 2003; Roux de Buisson 2009; Morrison & Gregor 2012; Zintzen et al.
2012; Díaz-Guisado 2014; Richardson 2015). Two main setups are available: (1) downward-facing,
which look down at the seabed (Figure 1) and (2) forward-facing, which look horizontally while lying
on the seabed (Figure 2). The downward-facing BUV system is relatively simple and inexpensive
compared to other available gear (for reviews see Cappo et al. 2006; Mallet & Pelletier 2014). It
consists of a triangular metal frame which serves as support for gear and has a calibrated field of
view, a container with bait to attract fishes, and one downward-facing high-resolution camcorder
which is sometimes linked to a monitor on the surface (Figure 1).
BUV units are normally positioned on soft sediment within 20–30 m from rocky reef habitat for 30
minutes (Denny et al. 2004; Langlois et al. 2010). This approach allows for unobstructed placement
on the seabed and consistency in the type of habitat sampled across different areas, e.g. reserve
and non-reserve sites. However, the final decision on the positioning of the unit will ultimately
depend on the objectives of the study, the particular configuration of the area being sampled or on
the methodology used in any previous sampling. Careful steps have to be taken when selecting
sites to obtain data that are statistically robust. In particular, if the objective is to follow the trend of
fish densities and size after protection, it is important to adequately sample within and outside the
protected area. Those steps are detailed in ‘Full details of technique and best practice’.

Inventory and monitoring toolbox: marine

DOCCM-1450395 Marine: baited underwater video surveys for fish v1.0

3

Typically, sampling is repeated annually, at a fixed time of the year (which varies with the species of
interest), and can be used in long-term monitoring to capture the trend of the fish population
demographic. In order to obtain usable time-series, methodology must be consistent across the
different sampling periods.

Assumptions


Water visibility is good enough to sample the fish species of interest. A general rule is that
BUV should not be conducted unless there is at least 2–3 m of underwater visibility. Visibility
should be sufficient to identify the fishes when reviewing the videos.



Oceanographic and geomorphological conditions at the different sites are similar. If not, the
bait plume dispersion could be significantly different between sites, which will confound
abundance estimates.



Bait type, quality and quantity are standardised. The same bait species should be used for
all deployments. Pre-frozen pilchards Sardinops sagax (Jenyns 1842) are recommended.



BUV units are consistently deployed on similar habitat type (e.g. on soft sediment at 20–
30 m of the reef edges) since this will have an influence on the type and abundance of
observed species. Species display habitat preferences.



Behaviour of species towards BUV units is not density-dependent. Density of species in a
sampling area can be, for example, influenced by the protection status or management
regime. This hypothesis has been recently challenged for snapper and needs further
research. This species might have larger home ranges in non-reserve sites and utilise more
than one main area, whereas reserve snapper had higher site fidelity with only one main
area of use (Parsons et al. 2010).



BUV deployments are independent from each other (i.e. are true replicates). To avoid
attraction of the same fish specimen to different deployments, consideration needs to be
given to factors such as current speed, length of deployment and distance between
deployments. For example, a minimum distance of 360 m between deployments is
recommended for deployments of 45-minute duration (assuming current speed of 0.2 m.s-1
and fish swimming speed of 0.6 m.s-1; this comprises 30 minutes of advection of the bait
plume down-current and 15 minutes of fish swimming time up-current to reach the field of
view in time to be recorded on the BUV; from Cappo et al. 2004, see details of calculation in
‘Full details of technique and best practice’).



Size frequency of individuals during highest observed abundance (MAXcount) is
representative of the size frequencies across the entire duration of the deployment. This
may not be the case, e.g. if smaller individuals are displaced by larger ones as abundance
increases at the bait.

Advantages


Gives estimates of relative abundance of species and allows specimen sizes to be
measured.
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Non-destructive method.



Can be deployed on a wide range of habitats.



Data beyond diver-accessible depths can be acquired.



Results are not affected by varying levels of water visibility, pending that visibility is sufficient
to view the seabed and identify the species.



High level of repeatability.



Few personnel needed on boat to operate.



Scientific divers not required, lowering the survey cost and need for expertise. Note,
however, costs associated with the processing of imagery, which can be significant.



Several self-contained units can be used at the same time.



Provides a permanent record that can be re-analysed in the future.

Disadvantages


Biased toward sampling carnivorous fishes. Although other fishes can also be attracted to
the bait (Harvey et al. 2007), they will more likely be seen using a forward-facing system.



Counts are likely to be underestimated, as not all individuals will be seen at any one time on
a video frame grab. For relative comparisons between sites, this problem only matters if the
degree of underestimation is density-dependent.



Size frequencies are based on measuring specimens during highest observed abundance
(MAXcount) but could potentially be density-dependent.



The bait plume will change according to current and geomorphology of the area, affecting
how many fish will be attracted to the video unit.



Post analysis is time-consuming and requires software knowledge and ability to identify
species on video.



Identification of small species (e.g. triplefins) can be difficult or impossible with downwardfacing BUV systems and current video resolution. However, most species commonly studied
with this system are usually easily identified with dorsal shots at current image resolution.



Inter- and intra-specific interactions may prevent some individuals, size classes or species
reaching the bait.



Noise generated from vessels (particularly diesel powered) can either attract or deter reef
fishes during BUV deployment and retrieval, therefore potentially biasing fish surveys (De
Robertis & Handegard 2012).



Potential limitations occur around the accuracy of size estimates for specimens measured at
the periphery of the field of view, where wide-angle lens distortion is likely to be greatest,
and for those occurring at heights well above the bait container. This disadvantage can be
alleviated by the use of stereo BUV systems or single-camera forward-facing systems for
species where a relationship between relative eye size and body length for the considered
species exists (Richardson 2015).
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Saturation, although rare, can occur in the field of view when too many individuals are
present around the bait, preventing them from being all visible at any one time.

Suitability for inventory


Inventories of large scavenger and carnivorous species may be possible.



The technique is strongly biased towards large scavenger and carnivorous species which
are attracted to the bait; consequently, it is unsuitable for inventories of herbivorous species
or for assessing the fish richness of an area.



Inventories of small species (e.g. triplefins) are limited by both the resolution of the video
and potentially by the configuration of the video system. Downward-facing systems only
offer a dorsal view of individuals while forward-facing systems offer lateral views that are
more useful for fish identification.



Incidental data on aspects such as benthic habitats can be collected.

Suitability for monitoring


This method is suited for monitoring scavenger and carnivore fish species (Willis & Babcock
2000; Harvey et al. 2004; Shortis et al. 2009). It can provide information on the relative
abundance and size class distribution of these species.



Consideration of the timing of BUV surveys is crucial in designing monitoring studies
because some species undergo seasonal migrations or dietary shifts depending on
ontogenetic stage and season. For example, Willis et al. (2003) observed seasonal peaks in
abundance of snapper, which they attributed to seasonal migrations (although facets of diet
and feeding may have also been important in explaining the observed patterns).

Skills
BUV systems require a moderate level of expertise to both assemble and use in the field. More
extended expertise is required for processing and analysing the video data post-fieldwork.
Pre-survey:


Survey design skills for determining the number of replicates, stratification (if any) and
placement of replicates, and what variables are to be recorded



GIS knowledge for the positioning of sampling sites



Transfer of sites coordinates to portable GPS

In the field:


Knowledge of video equipment and its use at sea



Familiarity with deploying gear at sea
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Good fitness and upper body strength is required for deploying and retrieving BUV systems
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Processing of imagery:


Fish identification skills



Familiarity with MS Excel and image analysis software

Data analysis:


Familiarity with basic statistics



Familiarity with statistical package (R recommended)

Resources
BUV setup and associated equipment
This section outlines the equipment required for a typical BUV survey, but more details are given in
‘Full details of technique and best practice’. A scaled drawing with specific dimensions of a standard
downward-facing BUV unit is given in Figure 1A. Other, more stable systems are also in use in New
Zealand (Willis & Babcock 2000). They have the advantage of moving less once deployed on the
seabed, avoiding scaring fishes (especially snapper, T. Willis pers. comm.), but at the cost of
heavier weight and more difficult manipulation in the field. Recent tests at the Poor Knights Islands
comparing the L Frame used by DOC and the sturdier frame used by Willis and Auckland University
did not show significant effect on the number or sizes of snapper observed at the bait (V. Zintzen,
pers. comm.). Effect size was very small (0.25 for counts and 0.10 for size expressed in mm). With
these results, a sample size of n = 492 and n = 4738 would be required to produce a significant
difference at α = 0.05 and power = 0.80. The number of deployments was, however, relatively low
(n = 24) and should be expanded to confirm these findings.
The main components of BUV which may change over time with technology advancements are the
camera and housing. Increased video resolution might improve identification of small or difficult-toidentify fish species. A checklist of equipment and consumables required for fieldwork is provided in
Table 1.
The BUV unit is constructed of three main parts (Figure 1):
1. Camera housing that contains a removable digital video recorder.
2. A base scale bar that sits on the seabed when deployed.
3. A movable angled bar that links the scale bar and the camera housing.
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Camera housing - 210 mm

1045 mm

Bottom scale bar - 1500 mm

25 mm
25 mm

C

B

D

Figure 1. BUV unit used by DOC: (A) drawing with accompanying measurements (mm) for camera
housing, angle bar, and bottom scale bar; (B) photo of unit ready to be deployed; (C) BUV placed on
soft sediment substratum within 20 m of rocky reef habitat; and (D) a more complex and stable frame
used by Willis & Babcock (2000) and Auckland University.
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Figure 2. Forward-facing BUV system deployed by Te Papa scientists off the Three Kings Islands. Note the
heavyweight bars at the base of the unit, the two video housings for the stereo system, which allows for
measurement in three dimensions, and the lighting system. This unit is set up to be sent to 1200 m. Similar
but lighter units are used at shallower depths.

Human resources
Survey work will require a minimum of two people (a boat skipper and crew to deploy and retrieve
the BUV), although three people are recommended.
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Table 1. BUV checklist—main hardware, tools and consumables.

Last updated:

By:
Checked


Item

Working


Replacement
date

HARDWARE
Camera stand and accompanying screws
Camera housing and o-ring
Lens and accompanying screws
Video camera and spare batteries
Drop camera including surface screen,
RCA video cables and 12 V battery
Bait pot
GPS (spare batteries if stand-alone)
Depth finder
Clock
White board, marker pen and data folder
Pressure buoy including spare
Surface float and rope
Rope (general)
TOOLS
Flat head screwdriver
Phillips screwdriver
Square-drive screwdriver
Pliers
CONSUMABLES
Hose clamps
Carabiners
D-shackles
Electrical tape (black and white)
Bait
O-ring
DV tapes, DVDs or memory cards
Paper towels
Hand towel
Anti-fog solution
Rubber bands (assorted)
Cable ties (assorted)
Spare screws (assorted)
Silicone grease
Silica gel
Fuses (10–20 amp) for drop camera
Polypropylene rope—spare (10 mm dia.)
SCUBA gear
Fish bins for storing ropes
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Minimum attributes
Consistent recording and measurement of the following attributes is critical for the implementation
of the method. Depending on the research question(s), other attributes may be required.
DOC staff must complete a ‘Standard inventory and monitoring project plan’ (doccm-146272).1

Data collection
The minimum set of attributes to be collected when deploying BUV units is presented in A data
sheet for logging information while at sea is available online: ‘BUV deployment data sheet’ (doccm2618429).
Table 2.
A data sheet for logging information while at sea is available online: ‘BUV deployment data sheet’
(doccm-2618429)2.
Table 2. Minimum set of attributes to be collected when deploying BUV units.
Field

Description

Value

Location

General location where the survey took place (e.g.
Ulva Island).

Short text

SiteName

The name of a site located within Location where
the unit was deployed.

Short text

DeploymentID

A unique identifier during this survey for this video
deployment.

Unique number

ReplicateWithinSite

Number of replicate within the site, starting at 1
and up to the number of deployments achieved at
that particular site. Note that if only one
deployment was achieved per site, then this field
takes the value 1 throughout.

Integer

ProtectionStatus

Indicates the protection status of the area sampled.

One of the six values:


RecordedBy

First and last name of the person who recorded the

1






Marine reserve (type 1
MPA)
Type 2 MPA
Mātaitai
Taiāpure
Other protection



No protection

Short text

http://www.doc.govt.nz/Documents/science-and-technical/inventory-monitoring/im-toolbox-standardinventory-and-monitoring-project-plan.doc
2
http://www.doc.govt.nz/documents/science-and-technical/inventory-monitoring/im-toolbox-marine-buvdeployment-data-sheet.pdf
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metadata during the survey (onboard the vessel).
Vessel

Name of the vessel used for the survey.

Short text

BUV_type

Describes the type of BUV used for the survey, e.g.
L-frame, Willis frame.

Short text

CameraModel

Describes the type of camera used for the
deployment (make and model).

Short text

LensModel

Describes the type of wide angle lens used for the
deployment, if any.

Short text

BaitSpecies

Name of the bait species used.

Short text

BaitAmount

Amount of bait used for deployment (g).

Number

Latitude

Decimal degree latitude for the deployment
(WGS84) (e.g. latitude for Wellington Conservation
House is −41.289904).

Number with up to 6 digits after
decimal. Values are between
−90 to 90, but typically negative
for New Zealand.

Longitude

Decimal degree longitude for the deployment
(WGS84) (e.g. longitude for Wellington
Conservation House is 174.775043).

Number with up to 6 digits after
decimal. Values are between 0
and 360.

Depth

Depth in metres of the deployment as recorded by
the sonar of the boat.

Number

EventDate

Date at which the deployment was made.

Date (dd/mm/yyyy)

EventTimeStart

Time the unit entered the water.

Time in 24 h format (hh:mm)

EventTimeEnd

Time the unit was retrieved from the seabed.

Time in 24 h format (hh:mm)

UnderwaterVisibility

Estimation of the water visibility, in metres, as
assessed with a Secchi disk or description of the
water visibility as seen from the video deployment,
with three categories: good, fair, poor.

Integer or one of three values
‘Good’, ‘Fair’, ‘Bad’

Habitat

Brief description of the nature of the seabed (mud,
sand, gravel, cobbles…)

Unlimited text

ReefDistance

Distance in metres from the reef at which the unit
has been deployed, as estimated from the boat

Integer

Weather

Description of the atmospheric conditions (wind,
sea state, swell…)

Unlimited text

NotesDeployment

Any additional notes of interest in relation to this
deployment.

Unlimited text

Linking video footage to metadata
It is essential to be able to link the footage of a deployment to its metadata (lat, long, depth, etc.)
once back from the survey. To this effect, the first seconds of a deployment should record
information such as Location, SiteName, EventDate and DeploymentID that the experimenter has
written on a whiteboard.
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Video processing
The following minimum attributes should be recorded when processing the video images:


MAXcount for each species of interest



Total Length, which should be estimated for each individual belonging to a species of
interest in the MAXcount frame

See ‘Analysis, interpretation and reporting’ for details on those measures.

Data storage
DOC is currently developing a national database to hold and provide access to data collected from
marine reserve monitoring in New Zealand. The aims of the database are to:


Support consistent standards in national marine reserve monitoring programmes for marine
environmental quality



Coordinate and optimise marine reserve monitoring in New Zealand



Provide a high quality monitoring dataset for New Zealand’s marine reserves

Once operational, this methodology will be updated with a description of how to lodge data within
the national database. In the interim, data should be recorded within the spreadsheets associated
with this methodology. It is essential that all raw data sheets are completed, digitised and backed
up on external hard drives. Raw data and associated metadata should be entered into
databases/spreadsheets in a standardised format. This should include metadata stored in a
separate sheet, and a sheet containing sampling data collected during the monitoring programme
stored in one ‘brick’ of data that can be continually updated as more surveys in that monitoring
programme are carried out.
For internal DOC monitoring, information pertaining to each survey within a marine reserve and
resultant data/reports should be entered into the Marine Protected Area Monitoring and Research
(MPAMAR) datasheet (‘MPAMAR metadata—National’—doccm-1163829) so there is an easily
accessible account of the survey.

Management and storage of raw data
It is essential that all raw (unprocessed) video data are labelled and stored in a suitable manner.
Depending on the storage medium (e.g. hard drive, DVD, digital tape, memory cards, etc.) ensure
that, as a minimum, the survey date and sites surveyed accompany each format (e.g. Figure 3).
Other supporting notation (e.g. surveyors, boat, etc.) may also be of value. Generally, adhesive
writeable labels are supplied with DV tapes, and DVDs and memory cards can be written on with
permanent marker.
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Figure 3. Example of labelling for raw BUV data stored on digital video tape.

Following field sampling, raw (unprocessed) video data should be digitised and backed up to a
computer hard drive. Paper forms should also be digitised and backed up along with the video data.
Appropriately labelled folders and subfolders should be created and used to archive the data. To
ensure multiple copies are in existence, the downloaded data should be backed up further to
external hard drives.
Editing can be done in programs such as Windows Movie Maker; however, when rendering edited
data, ensure that the highest video quality settings are used (i.e. do not sacrifice video quality for
storage space). It is preferable to capture and edit data for each site and place them into a separate
video folder with corresponding date and site name, thus ensuring copies of both raw and edited
data are archived. When editing video, be sure to retain the frames that contain the site details and
entire descent of the BUV unit from vessel to the seabed.

Management and storage of edited data
Due to continuous filming over consecutive video drops, raw video will contain a range of
unnecessary material that may require editing (removal) before formal analysis and archiving.

Analysis, interpretation and reporting
Seek statistical advice from a statistician or suitably experienced person prior to undertaking any
analysis. It is also essential that statistical advice is sought prior to any data collection to ensure
that the design of the data collection is robust and suitable for answering the question at hand. For
quality control, the data should be checked for unlikely abundances of organisms, and errors in data
entry. Further information on analysis, interpretation and reporting can be found in ‘Full details of
technique and best practice’.

Data acquisition phase
To acquire usable data metrics, the video footage will have to be reviewed using specialised
software. Procedures to obtain such data are given in ‘Full details of technique and best practice’.
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Data metrics
The key abundance metric is MAXcount (Willis et al. 2000) for each species of interest, i.e. the
maximum number of specimens for each species of interest found during the length of the
deployment. To find MAXcount for each species, the maximum number of individuals of each
species can be measured at every 30- or 60-second interval. This means that the reviewer will
analyse the maximum number of individuals that are present over a period of 30 or 60 seconds,
take note of this, and repeat the process for the next 30 or 60 seconds. MAXcount will be the
highest value recorded for the intended length of deployment from all values. This metric has the
advantage of avoiding multiple counts of the separate visits of the same individual fish to the field of
view, and as such, are conservative estimates of abundance. Refer to Willis et al. (2000) for
background information pertaining to MAXcount. Specimens that compose the MAXcount are then
used for size analysis.
The key size metric is Total Length (often abbreviated TL), which should be estimated for each
specimen in the video frame where MAXcount was identified. This procedure should be repeated
for each species of interest. Size analysis is done with image measurement software. It is
sometimes recommended to record the size of small fishes appearing early in a deployment and
having been scared off by larger specimens when MAXcount was recorded, as was observed for
snapper by Willis et al. (2003). Additional data may be useful to collect, depending on the objective
of the survey. For example, when the objective is to assess the effects of protection (or conversely,
effects of fishing) it may be useful to divide the size data into legal and sub-legal size classes based
on commercial and recreational minimum size limits. This will ultimately depend on the fisheries
management area and, in some instances, timing of the survey.
If the MAXcount occurs in multiple 30- or 60-second windows, then length measurements should be
made for specimens of the first window where MAXcount was observed in order to minimise
potential effect of bullying on size frequencies analysis.

Recommended approach
As a general approach to presenting and analysing count and size data, the following steps should
be undertaken:


Undertake exploratory data analysis and graphically present data using central tendency
measures (e.g. arithmetic mean and measures of error).



Test data for violation of assumptions of normality, homogeneity of variance and
independence via residual analysis if the data is to be tested using a normal model, like an
ANOVA (see Zuur et al. 2007 and Zuur et al. 2009 for summary and worked examples).



Undertake formal statistical analysis to test main hypotheses—preferably generalised linear
modelling (GLM) using a Poisson distribution framework for count data (see Zuur et al. 2009
for summary and worked examples). Size data may be amenable to analysis of variance
(ANOVA) or t-test analysis.
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Data exploration and analysis
Following the data acquisition phase, there should be two sets of data generated for each BUV
drop. The first set corresponds to MAXcounts for the various species enumerated, and the second
dataset corresponding to sizes for each specimen constituting the MAXcount (Figure 4).
Once raw count and size data have been collected and collated, and data quality checks run, formal
data analysis can be undertaken. The data analysis techniques presented in this section are not
exhaustive and the theory underpinning some of the techniques is well beyond the scope of this
document. As a prerequisite, the analyst should be familiar with linear and non-linear regression.
The statistical references of Zuur et al. (2007) and Zuur et al. (2009) provide an excellent
background and foundation regarding statistical inference and analysis of the type required to
examine count and size data.

Figure 4. Example data sheet displaying MAXcounts for several species of BUV deployment at Tapuae
Marine Reserve (Taranaki), using a 30-second interval.
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Exploratory data analysis
Following data collation, exploratory data analysis is a convenient way to examine the structure of
the data, identify potential outliers, and get a general feel for the data prior to formal analysis. This
may include summary statistics for a particular variable, such as measures of central tendency (i.e.
mean, median and mode) or the data spread (e.g. range, quartiles, interquartile range, variance and
standard deviation).

Graphical presentation of data
Presentation of data in graphical format is essential for ecological studies, primarily as a means to
convey patterns (often changes) to the reader in specific metrics (size and counts) through space
and time. For protected-area surveys, data are divided into protection regime (e.g. reserve and nonreserve components) and compared in this manner. Plotting can be done adequately in R statistical
software (R Development Core Team 2011).

Box plots
Constructing box plots is a useful way to display data to examine differences between sampled
populations. It depicts groups of numerical data based on quartiles, with the bottom and top of the
box representing the first (Q1) and third (Q3) quartiles, and the band inside the box corresponding
to the second quartile (median). The mean is often highlighted by a dashed line. The spaces
between the various quartiles are helpful in evaluating the spread (dispersion) and skewness
(tendency to lean to one side of the mean) of the data, as well as highlighting outliers. Further, this
data representation does not assume it belongs to a specific distribution, i.e. it is non-parametric.
Ends of the whiskers can denote a range of measures. Common representations are: minimum and
maximum of all data, highest value still within 1.5 × IQR (inter-quartile range) of the upper quartile
and lowest value still within 1.5 × IQR of the lower quartile, and the 10th and 90th percentile.
Outliers are values that fall outside the upper and lower whiskers, and by convention are denoted
by round symbols.
Box plots can be constructed in R (using the ‘boxplot( )’ function). Due to the differing values that
the end whiskers can represent, the method of whisker formulation will need to be stated in the
caption accompanying the plot.
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Figure 5. Example box plots
generated for snapper MAX
abundance within and outside Te
Whanganui-A-Hei Marine Reserve in
2012. Percentiles are depicted
accordingly. Whiskers denote 10th
and 90th percentiles and outliers are
represented by round black symbols.
From Haggitt et al. 2014 (BRUV =
baited remote underwater video).

Count data
Count data for MAXcount, LEGcount (legal size specimens), and JUVcount (juvenile specimens)
are typically presented as an average of the sample population (sample mean) (Figure 6). This is
computed across reserve and non-reserve sampling stations, if this is the factor being tested, as
well as for individual blocks (Figure 7 and see ‘Case study B’ for an explanation of the term ‘block’).
A measure of the error around the sample mean should always be given. The standard error (SE),
which represents an estimate of the standard deviation of the distribution of a given sample mean
(taken from a population), is a commonly used statistic.

Size data
Size data can be effectively presented as frequency distributions or in box plot format (Figures 6, 7,
& 8). Both allow the reader to visualise the spread of sizes within the sample population and assess
skewness (defined as the asymmetry from the normal distribution in a set of statistical data).
Computing the frequency of the data is simply a matter of counting the number of times a score
appears in the set of data. It is necessary to include scores with zero frequency in order to draw the
frequency histograms correctly. Size class divisions can affect interpretation, so here we suggest
using 20 mm size increments (or bins) when constructing frequency histograms (Figure 8). Speciesspecific size data can also be converted to biomass using length–weight relationships (see Taylor &
Willis 1998; Roux de Buisson 2009).
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Figure 6. Long-term trends in the relative density of snapper Chrysophrys auratus inside and outside Te
Whanganui-A-Hei Marine Reserve, as measured using BUV from October 1997 to April 2012. (A) All snapper
(MAXcount); (B) legal snapper (LEGcount, > 270 mm fork length); and (C) undersize snapper (JUVcount,
< 270 mm fork length). From Haggitt et al. 2014.
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Figure 7. Average number of legal-sized
snapper Chrysophrys auratus recorded in
the six areas (blocks) surveyed within
and adjacent to Te Whanganui-A-Hei
Marine Reserve from 2004 to 2012, as
measured using BUV. Dashed vertical
lines indicate the reserve boundaries. R:
reserve, NR: non-reserve. From Haggitt
et al. 2014.

Figure 8. Size frequency distributions of
snapper Chrysophrys auratus inside (left)
and outside (right) Te Whanganui-A-Hei
Marine Reserve from 2006 to 2012, as
measured using BUV. Dotted line
indicates recreational legal size limit
(270 mm). Note: y-axis differs among
plots. From Haggitt et al. 2014.
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Formal data analysis
All sampling programmes should be directed by clear monitoring objectives supported by a central
hypothesis or range of hypotheses. For a statistical hypothesis test, two hypotheses are appraised:
the null (Ho) and the alternative (Ha). The null hypothesis is assumed true until proven otherwise.
For example, the fundamental null hypothesis pertaining to many monitoring surveys is:
Ho There is no statistically significant difference in the abundance and size of fishes (e.g. snapper,
blue cod, tarakihi, etc.) inside and outside a marine reserve.
The corresponding alternative hypothesis is:
Ha There is a statistically significant difference in the abundance and size of fishes inside and
outside a marine reserve.
However, in addition to presenting statistical significance (or not), effect size and its associated
error should be reported so that the relative size of an effect can be assessed (e.g. is the significant
difference we observe between those two groups marginal or large/important?)
Because BUV count data routinely fail the assumptions underpinning ANOVA (i.e. normality of
errors, homogeneity of variances and independence) even following commonly prescribed
transformation procedures (e.g. LOG(x+1) transformations), we recommend that count data are
analysed using GLMs with a Poisson error distribution (see McCullagh & Nelder 1989; Willis et al.
2003; Zuur et al. 2009). It should be noted that it is increasingly recommended not to log-transform
data prior to analysis because transformations affect the results of the model applied to these data
(McArdle & Anderson 2004; O’Hara & Kotze 2010). In some specific cases, subsets of the data
(such as legal-sized counts in the case of protected versus fished comparisons) may also be zeroinflated—i.e. the response variable (in this case, counts) contains more zeros than expected based
on the relevant distribution (e.g. Poisson, negative binomial etc.)—which can be better managed
using GLMs. Further, GLMs have been applied to the majority of BUV surveys conducted in New
Zealand over the last decade.
For size data, which are continuous (can take any value within a range), analysis by ANOVA or ttest may be appropriate, providing the assumptions of normality, homogeneity of variances and
independence are satisfied, which may require transformation (e.g. LOG transformation). However,
transforming the data prior to an ANOVA is not recommended if the experimenter is interested in
effect size. Data failing to meet ANOVA assumptions should be tested using non-parametric
techniques such as the Kruskal–Wallis test (non-parametric analogue of ANOVA) and Wilcoxon
rank-sum test (analogue to student’s t-test). Comparisons of size frequencies can be done using a
Kolmogorov–Smirnov test or Kernel density estimates (Langlois et al. 2012, and see function
‘clus.lf’ from package ‘fishmethods’ in R).

Data interpretation
Interpretation of results should be performed with the assistance of a statistician as well as
consideration of the major driving forces operating within the system. At this stage, it should be
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determined whether the goals of the original data collection have been achieved and whether the
data is sufficient to answer those questions identified prior to the initial surveys.

Data reporting
Reporting will largely be governed by the duration of the monitoring and data collection. If data
collection is ongoing, regular reports should be submitted at 3–5-year intervals, whereas for shortterm (< 2 years in duration) data collection, reports should be submitted within a year of the final
data collection.

Case study A
Case study A: High density and biomass of snapper Pagrus auratus (Sparidae) in northern
New Zealand marine reserves (Willis et al. 2003)

Synopsis
BUV data was used to show that snapper (Pagrus auratus, now renamed Chrysophrys auratus,
Sparidae) density and biomass are much higher inside compared to outside marine protected areas
(MPAs) in northern New Zealand. This effect was mostly due to the increase in number and size of
legal-size snapper within the MPAs. Video units were deployed at several times and locations,
allowing for a compelling dataset to be compiled. Biomass of snappers was estimated from weight–
length relationship, after measuring fish lengths on the videos.

Objectives
The aim of the study was to assess the general effects of MPAs by using spatially and temporally
replicated surveys. Specifically, the authors wished to:


Determine the magnitude of differences in snapper density and size between MPAs and
adjacent fished areas, taking into account that undersize (unexploited) fish should not be
affected by the protection status



Quantify seasonal and inter-annual variability in snapper density and size.

Sampling design and methods


The relative density and size structure of snapper were measured using BUV, inside and
outside three northern New Zealand no-take MPAs (Cape Rodney to Ōkakari Point Marine
Reserve, Te Whanganui-A-Hei Marine Reserve and Tawharanui Marine Park).



Each MPA was divided into blocks and 4–5 sampling sites were selected within each block.



Each sampling site was visited in October 1997, April 1998, October 1998 and April 1999.



BUV was used because it avoided attraction or avoidance problems of snapper towards
divers.



BUV units were deployed within 50 m of reefs, on soft sediments.
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The density of snapper was described using MAXsna, LEGsna (legal size fish) and JUVsna
(illegal or juvenile fish size). Biomass was also estimated using a weight–length relationship
derived from the literature.



The data were analysed using GLM under the assumption of a Poisson distribution. Factors
were ‘location’, ‘protection status’ and ‘survey’.

Results
General effects on density:


Biomass per BUV deployment and density of legal-size snapper (LEGsna) were higher in
the MPA than adjacent non-MPA areas at all three locations and for all four surveys (Figures
9 & 10).



There was a 14.3-fold higher density in LEGsna inside MPA areas compared with the
adjacent non-MPA areas (95% confidence limits of 10.0 and 20.5).



At the three locations, MAXsna, LEGsna and biomass were all significantly higher (i.e. 95%
confidence intervals lying entirely above unity) in the MPA than in the adjacent non-MPA
region.



The relative density of undersize fish (JUVsna) varied between locations, with higher
reserve densities at Te Whanganui-A-Hei, lower reserve densities at Cape Rodney to
Ōkakari Point, and no difference in densities within and outside Tawharanui.

Seasonal effects on density:


The estimated additive effect of season within the three MPAs was a spring-to-autumn
mean increase.



For undersize snapper (JUVsna) and all snapper (MAXsna) there was considerable amonglocation variability that was partly attributable to patchiness in the distribution of undersize
fish, leading to a significant interaction between location and season. If different MPAs are
surveyed at different times of year, the results will not be comparable, and will give
misleading impressions of the relative effectiveness of the different MPAs.



Individual season estimates are also given for each location.

Effects on size:


The mean length of snapper was greater within MPAs than in fished areas at all three
locations.



Kolmogorov–Smirnov tests run on fish ≥ 270 mm fork length found a significant difference
between the reserve and non-reserve size structure at Cape Rodney to Ōkakari Point (D =
0.55, P < 0.01) where almost all non-reserve fish were < 400 mm fork length. The
comparison was not significant at either Te Whanganui-A-Hei or Tawharanui.
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Limitations and points to consider


A true Before–After–Control–Impact (BACI) design (Hurlbert 1984; Underwood 1993) could
not be implemented because of the absence of comparable data prior to MPA
establishment. However, the design of the study reduced the risk of location-specific biases
that may have been present due to the lack of ‘before’ data, which in MPA studies are often
unobtainable.



Behaviour of species towards BUV units could be influenced by protection status. It is
possible that the response to bait of resident fish could be stronger in marine reserves due
to density-dependence. However, this hypothesis has never been tested.



A study showed that snapper might have larger home ranges in non-reserve areas and
utilise more than one main area, whereas reserve snapper might have higher site fidelity
with only one main area of use (Parsons et al. 2010). If this behaviour was confirmed, it
could potentially influence the conclusions of any study comparing snapper inside and
outside reserves. It should be noted that Parsons inference could be merely an artefact of
the short survival time of any fish trying to be resident on a heavily fished reef (Willis, pers.
comm.).

Figure 9. Mean density for (a) all size classes and
(b) biomass of snapper Chrysophrys auratus at
reserve (filled symbols) and non-reserve (open
symbols) at Leigh (Cape Rodney to Ōkakari
Point), Hahei (Te Whanganui-A-Hei) and
Tawharanui from November 1997 to April 1999.

Figure 10. Mean density for (a) fish larger than
minimum legal size and (b) for fish smaller than
minimum legal size of snapper Chrysophrys
auratus at reserve (filled symbols) and nonreserve (open symbols) at Leigh (Cape Rodney
to Ōkakari Point), Hahei (Te Whanganui-A-Hei)
and Tawharanui from November 1997 to April
1999.
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Case study B
Case study B: random site selection for BUV deployments using hypothetical example
This section provides a method for obtaining random sites within and outside a hypothetical
reserve. The example assumes basic knowledge of ArcGIS and also uses add-ons like Hawth’s
Tools available from SpatialEcology.com for ArcView 9.x
(http://www.spatialecology.com/htools/index.php) or Geospatial Modelling Environment for ArcView
10.x (http://www.spatialecology.com/gme/gmedownload.htm). For open-source solutions, the
software QGIS also offers random selection tools (Vector menu > Research Tools > Random point).
The distribution of rocky reef and soft sediment areas within and outside the reserve were known
prior to site selection. The latter is a necessary requirement before undertaking a survey of this
nature.
The underlying hypothesis is:
Ho There is no statistically significant difference in snapper and blue cod abundance and size
between reserve and non-reserve sampling areas.
The sampling design will be a randomised block design and all BUV drops are required to be done
within 20 m of rocky reef habitat on soft sediment substratum. There is a fairly even spread of rocky
reef and soft sediment habitat types across the survey area (Figure 11).
Key steps to obtain random sites are:
1. Create a spatial map of the reserve and non-reserve sample areas in ArcGIS based on
relevant shapefiles and associated metadata, e.g. bathymetric data and spatial habitat
maps. A map of rocky reef and soft sediment habitats has been created based on preexisting data (Figures 11 & 12).
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2. Designate blocks within reserve and non-reserve sample areas based on available habitat
information, ensuring that blocks are broadly spatially equivalent (Figure 13).
3. For this survey, the sampling requirements are:
a. A total of 5 replicate BUV drops per block.
b. Individual BUV drops will be done within 20 m of rocky reef habitat on sand.
c. Individual BUV drops will be of 30-minute duration once the BUV unit has settled on
the seabed.
d. Individual BUV drops will be a minimum of 360 m apart to avoid sampling the same
fish due to overlapping area of attraction. A distance of 450 m or greater between
replicate BUV deployments of 60-minute duration is recommended by Cappo et al.
(2004) to achieve independence between replicates. We have reduced this to 360 m
based on the reasoning that: (1) BUV deployments are shorter (30 minutes); and (2)
so sufficient replication can be achieved within blocks, particularly in the case of
smaller marine reserves or those that may have limited reef habitat.
4. Construct a grid composed of 200 × 200 m cells that covers reserve and non-reserve survey
areas. The grid will be used to facilitate site selection within selected cells (Figure 14).
5. Select cells from running a specific ‘Attributes Selection’ query that picks those grid cells
which together contain rocky reef habitat and sand habitat, i.e. where boundaries of rocky
reef and soft sediment habitat intersect and create a new shapefile based on this selection
(Figure 15).
6. From these available cells, generate a total of 6 random points per block (using either
Hawth’s Tools or Geospatial Modelling Environment). In this instance we have chosen 6
sites (we only need 5) to build some redundancy into the programme should a particular site
prove to be unsuitable in the field (Figure 16).
7. A point-based shapefile is now created and latitude/longitude coordinates generated
(Figures 17 & 18 and Table 3).
8. Generated latitude/longitude coordinates can then to be loaded into a suitable GPS unit and
will serve as the initial site waypoints. Note: The initial site mark may need to be adjusted in
the field to satisfy placement of the BUV system within 20 m of reef habitat.
Table 3. Randomly generated sites for BUV drops within and outside the marine reserve.
Block

Status

R1

Reserve

Site

Rep

Latitude

Longitude

1

1

2011276

5813964

2

2

2013263

5814392

3

3

2014756

5817389

4

4

2013786

5818749

5

5

2012562

5818794

6

6

2013182

5819450
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R3

NR1

NR2

NR3

Reserve

Reserve

Non-reserve

Non-reserve

Non-reserve

26

7

1

2015227

5819347

8

2

2016648

5820260

9

3

2015332

5816839

10

4

2015246

5818773

11

5

2015058

5817456

12

6

2014296

5818838

13

1

2020565

5820033

14

2

2019951

5820379

15

3

2023577

5820786

16

4

2025700

5821529

17

5

2023007

5820121

18

6

2021150

5820387

19

1

2011308

5812268

20

2

2009714

5813648

21

3

2010450

5812681

22

4

2009311

5813659

23

5

2012182

5811529

24

6

2010416

5809104

25

1

2029429

5828153

26

2

2030578

5825233

27

3

2026223

5821068

28

4

2029443

5827567

29

5

2030752

5824217

30

6

2029650

5822635

31

1

2037127

5827411

32

2

2033705

5826213

33

3

2035914

5825409

34

4

2036758

5825254

35

5

2035084

5825140

36

6

2030368

5827899
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Soft sediment
Rocky reef

Figure 11. Distribution of soft sediment and rocky
reef habitats at a hypothetical study site.

NR3

Figure 12. Localisation of the marine reserve
area within the study site (blue).

0.04 km2 grid cell

NR2
R3
R2
R1
NR1

Figure 13. Reserve (R1–R3) and non-reserve
(NR1–NR3) block designation across the reserve
and non-reserve areas.

Figure 14. Reserve and non-reserve blocks
gridded into 200 m x 200 m cells.

Figure 15. Identification of cells which have both
rocky reef and soft sediment habitats. They show
the locations of the boundaries of rocky reefs.
Figure 16. Random site selection using Hawth’s
Tools for ArcView 9.x.
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● Reserve
● Non-reserve

Figure 17. Random site designation (n = 6) within
each block.

Figure 18. Final random site designation.

Full details of technique and best practice
The exact survey/monitoring design will be governed by the research question, but the following
text details the techniques and general survey design to be used when conducting BUV surveys.

Survey design
Monitoring preparation includes developing a robust survey design, including prior consultation with
experts/statisticians, to ensure the design meets the requirements to answer the research question.
The following aspects need to be incorporated into a robust survey design:


Identification of monitoring objectives.



Statement of clear outcomes of the surveys and how they relate to the original monitoring
objectives.



Determining what variables are to be measured, and how the data are to be recorded.



Determining the number of sites to be surveyed within the survey location, and where they
are to be situated. This will depend on the research question and if the survey is part of
ongoing monitoring, in which case the same sites are likely to be sampled.



Determining a survey schedule to ensure that data are collected as required over the
lifetime of the study. Sampling, if annual, should take place at a similar time each year.

BUV setup and associated equipment
The range of equipment needed for a typical BUV survey is as follows.

A. Camera and camera housing
A range of cameras and underwater housings are on the market and are continually being improved
and upgraded. Cheap units like those made by GoPro are also becomingly increasingly easy to
obtain and attach to frames. The experimenter should seek advice on what to buy from other
people active in this field.
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B. Frame
This frame, in use at DOC, has proven to be easy to assemble, robust and easily transportable.
There is currently little information about how fish behave around differing frames and so ensuring
consistency within and among surveys is imperative.
Material:

Aluminium square bar 25 × 25 mm for both the bottom scale bar and angled bar.

Length:

Bottom scale bar: 1700 mm, with 1500 mm (outer to inner) divided into black and white
segments each 100 mm in length (n = 15). The 100 mm segments can be delineated
with black and white electrical tape.
Side angle bar: Approximately 1415 mm from the base scale bar with a 150 mm vertical
bar for attachment of the housing.

The bottom scale bar and side bar are fixed at the desired angle via a removable top screw as part
of a fixed bracket. When the screw is removed the angled bar folds down so that the unit can be
stored efficiently. A fixed bottom screw ensures the two arms are permanently held together (Figure
19). Note: All screws and fasteners should be stainless steel marine grade 316 and should be
checked regularly for corrosion and replaced if necessary.

D
C
B

A

Figure 19. BUV frame in folded position with housing removed: (A) bottom scale bar; (B) base of bait pot; (C)
moveable angle bar; and (D) housing attachment section and associated drill holes used to attach to the
housing.

C. Bait container
A bait container (Figure 20) is required to enclose bait during a deployment. It also provides a point
of reference when measuring fish during post-survey analysis. The cylindrical burley container in
Figure 20A should be preferred as it produces superior odour plume characteristics and is readily
available. It is 100 mm in height and 130 mm in length and can be attached to the bottom frame
using cable ties and screws. The bait container in Figure 20C–E is an inverted burley pot with the
base (top) attached to the middle of the scale bar with hose clamps. The base of the bait container
is 130 mm in diameter and 150 mm in height. Bait containers can become damaged from fish attack
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during sampling. Therefore, it is advisable to carry spares on the vessel so that repairs can be
promptly made.

A

B

D
C

E

Figure 20. Typical bait containers used for BUV surveys: (A) cylindrical bait container on BUV frame
(preferred container); (B) preferred container on BUV unit; (C–E) bucket style bait container—for construction
purposes, the top is removed, inverted, and attached to the frame with hose clamps or screws.

D. Digital video camera
There is a range of digital video cameras available on the market. Purchase a reputable brand such
as Sony Handycam or Canon camcorder. GoPro cameras also offer a cheap way to record high
quality footage in a compact form. Newer video camera models offer high definition recording onto
a drive or memory card, which preserves battery consumption considerably. The best option is a
camera which records on a memory card so that the number of samples one can achieve in the
field is not limited by the size of the hard drive. Simply have several memory cards and swap for a
new one when necessary.
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A semi-fisheye lens attachment (e.g. Raynox QC-303 or equivalent) will be required to ensure the
majority of the scale bar is visible in the field of view. It is important that the horizontal length of the
field of view at seabed level be of about 1500 mm so that the sample size is consistent (i.e. that
fishes are always counted over a similar surface around the bait). Ensure the lens is compatible
with the video camera. Distortion may need to be taken into account when processing the video
(see ‘Managing biases when measuring fish lengths’, page 44). Ideas on how to deal with distortion
are presented at page 44. If feasible in practice (e.g. if the video camera has a wide field of view or
if the system used and visibility conditions allow it), it is recommended not to use a fish-eye lens to
avoid distortion issues which can impact on fish length measurements.
When choosing a camera, specifically check:


Record modes relative to maximum continuous record time.



Battery life. The recording and playback time will be shorter when you use your camcorder
in low temperatures (i.e. underwater). Larger batteries can remain in continuous recording
mode for > 10 h and are the preferred option for fieldwork.



Storage medium types (hard drive, memory card, flash stick, tape, etc.). Make sure that
storage size will be sufficient to undertake the required level of sampling for a given day.



Lens specifications and level of distortion.

E. Drop camera
A drop camera (Figures 21 & 22) is often used as an alternative or in conjunction with the digital
video camera of the BUV unit proper. This system provides real time visuals so that
substratum/habitat suitability can be evaluated immediately once the BUV unit settles on the
seafloor. An assessment of this nature can save time, ensuring that kelp is not obscuring the field of
view and that the unit is in a suitable habitat and position on the seafloor.
The drop camera, if providing good image quality, can replace the housing/camera setup, and be
directly used to record the video data. In this case, the drop camera is directly attached to the BUV
unit. It will record video to a tape or hard drive it is connected to on the boat.
The drop camera attaches to the BUV unit with rubber bands, hose clamps or duct tape and is
linked (via coaxial cable) to a surface LCD monitor (or secondary video recorder that serves as a
monitor) and ancillary 12 V battery which powers the unit. Drop cameras can be custom built
specifically for this purpose in New Zealand by companies such as Marine Design Engineering Ltd
(http://www.mdel.co.nz/) and Ocean Data Systems (http://www.oceandata.co.nz), or can be ordered
online from a range of international suppliers. Allow for approximately 60 m of coaxial cable.
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Figure 21. BUV setup prior to deployment. Red
circle denotes Splashcam® drop camera. The drop
camera is in this case used to assess habitat
suitability at the start of the deployment. If providing
good image quality, the drop camera can also be
directly used to record the video data, effectively
replacing the video camera in its housing.
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Figure 22. Drop camera equipment: (A) MDEL drop
camera and 70 m coaxial cable; (B) 12 V
rechargeable battery pack used to power the drop
camera unit; and (C) digital video recorder with
movable screen. This setup is used for real time
substratum and habitat assessment. All
components are linked together in a customised
waterproof case (not shown). Note: The video
recorder is powered by a long-life (8 h) 7.4 V
battery pack specific to the video recorder.

F. Consumables
Alongside BUV hardware, a range of consumables are required to undertake field sampling (Figure
23). These range from fasteners such as cable ties and shackles to spare fuses and data sheets. A
full equipment checklist (hardware and consumables) is provided in Table 1.

A

D

B

C

E
I

G

F
L

H

M

K

J

N

Figure 23. Typical hardware and consumables
required for undertaking a BUV survey.
A. Fasteners (shackles, carabiners and hose
clamps)
B. Rubber bands, cable ties and spare screws
C. Digital video camera
D. Bait pots (other style preferred)
E. Rechargeable video camera batteries
F. Screwdrivers
G. Paper towels
H. Cable ties
I. Permanent marker pen
J. Electrical tape
K. Silicone grease
L. Drop camera
M. Pressure buoy
N. Cloth
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Video data management and storage
It is essential that all raw (unprocessed) video data are labelled and stored in a suitable manner.
Ensure that the survey date and sites surveyed accompany the storage medium (hard drive, DVD,
DV tape, memory card, etc.; Figure 3). Other supporting notation (surveyors, boat, etc.) are also
important. Generally, adhesive writeable labels are supplied with DV tapes, and DVDs and memory
cards can be written on with permanent marker.
Following field sampling, raw (unprocessed) video data should be immediately backed up or
captured to a computer hard drive. Appropriately labelled folders and subfolders should be created
and used to archive the raw video data (Figure 24). To ensure multiple copies are in existence,
copies of the downloaded data should be backed up further to external hard drives.
Paper forms should be photocopied or scanned so that multiple copies are in existence. If possible,
physical and electronic copies of the data should be stored at separate physical locations.

Figure 24. Example of folder specification for BUV video data. Folders should start with year and month of
collecting for easy sorting. The final folders of the hierarchy should correspond to the sites of each location.

Video capturing
If transferring data from DV tape to computer, an IEEE 1394 (FireWire) cable will be required to
bridge the two devices. Video will need to be captured directly from the camera using specialised
software (like WinDV (http://windv.mourek.cz/), or AVS Video Recorder
(http://www.avs4you.com/index.aspx and http://www.reviewstown.com/how-to-convert-vhs-tapes-todvd.html)).
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Digital video recorders with built-in hard drives or with memory cards have the option of transferring
data directly from the camera (via USB connection) to an external hard drive or DVD writer device,
which can then be transferred to the computer. Memory cards can be directly read using an
adequate reader and backed up to a hard drive.

Video editing
Due to continuous filming over consecutive video drops, raw video will contain a range of
unnecessary material that will require editing (removal) before formal analysis and archiving. Editing
can be done in programs such as Windows Movie Maker or Freemake Video Converter
(http://www.freemake.com/free_video_converter/), but ensure that, when rendering edited data, the
highest video quality settings are used, i.e. do not sacrifice video quality for storage space. For
each site-specific video, be sure to include the frames that contain the site details and entire
descent of the BUV unit from the vessel to the seabed.

Sampling design
Prior to conducting a BUV study, consideration should be given to developing a robust survey
design. This should include prior consultation with experts/statisticians to ensure the sampling
design meets the requirements to answer the research question. The following should be
considered:


What is the spatial extent of broad habitat types (rocky reef and soft sediment) and
exposure levels within and between areas to be sampled (e.g. reserve versus non-reserve
areas)?



What are the habitat extents within and among blocks for the different areas? Will it be
important to stratify the sampling based on these?



How many blocks are to be assigned for the different areas? Remember, it is always better
to create a balanced sampling design.



How many replicates (sites) per block are required? At this stage it will be important to
gauge statistical power and build some redundancy into the sampling design. Willis et al.
(2003) provide a detailed summary of this.



Ensure that individual sites are randomly assigned within the blocks.

The primary ethos of undertaking BUV surveys is to estimate the size and abundance of species
not amenable to sampling by techniques such as visual underwater census techniques.
For example, if the main objective is to compare abundance and size of certain species within and
outside MPAs, one would ideally undertake ecological surveys several times prior to the
commencement of MPA designation in order to obtain information on natural variation of target
species prior to protection. For the majority of early studies that developed the BUV technique
within New Zealand’s MPAs, there was a distinct paucity of pre-protection data. As a result, BACI
designs (Hurlbert 1984; Underwood 1993) could not be applied. In the advent of new MPA
designations, undertaking pre-protection surveys should be a requisite.
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Hypothesis testing
For the most part, all sampling programmes should be directed by clear monitoring objectives
supported by a central hypothesis or range of hypotheses. For a statistical hypothesis test, two
hypotheses are appraised: the null (Ho) and the alternative (Ha). The null hypothesis is assumed
true until proven otherwise. For example, the fundamental null hypothesis pertaining to many BUV
surveys is:
Ho There is no statistically significant difference in the abundance and size of fishes (e.g. snapper,
blue cod, tarakihi) between area A and area B (e.g. between a marine reserve and non-reserve
adjacent area).
The corresponding alternative hypothesis is:
Ha There is a statistically significant difference in the abundance and size of fishes between areas
area A and B.

Randomised block designs (see ‘Case study B’)
Randomised block designs are useful for MPA surveys (or other spatial protection or management),
primarily as the design allows for comparisons to be made among blocks within a particular spatial
area. Blocks are created by dividing the area to be sampled into units (=blocks) to account for any
variation in some factor. There is no concrete rule for block allocation within and outside MPAs. In
fact, the exact delineation of block boundaries often occurs subjectively among MPA and non-MPA
areas. For instance, Cape Rodney-Ōkakari Point Marine Reserve (CROP) and Te Whanganui-AHei Marine Reserve are similar in spatial extent, yet Willis et al. (2000) delineated a different
number of blocks across CROP (6 inside and 6 outside) compared to Te Whanganui-A-Hei (3
inside and 3 outside). This was due to funding and logistical constrains (Willis, pers. comm.). For
offshore locations, or reserves with disparate boundaries (e.g. Kapiti Island), block assignment may
be less intuitive. In such instances completely randomised designs may be more suitable, although
the experimenter would only be able to compare reserve and non-reserve data with no further
information on trends within blocks.
In the case of new MPAs or for those awaiting survey we suggest the researcher relates the
position and number of blocks and subsequent replicates (see below) back to the underlying
hypothesis and objectives of the programme. We advocate that sampling designs are balanced in
terms of both the number of blocks and replication within blocks between MPA and non-MPA areas.
Additional considerations include:


Are there distinct environmental gradients (depth, turbidity, wave exposure, reef contiguity)
that need to be accounted for in the demarcation of blocks within and outside the MPA? If
testing for an MPA effect, the investigator will want to control for those gradients.



Are there obvious habitat differences across sampled areas, e.g. is one half predominantly
soft-sediment and the other predominantly rocky reef and does this need to be accounted
for by way of habitat stratification?
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Replication
Replication is an essential component of marine ecological studies, and as a general rule every
level within the sampling programme should be replicated. Kingsford & Battershill (2000) provide a
useful overview on the subject. In past studies conducted in New Zealand, site replication within
blocks typically ranges from 4–5 per block, i.e. 4–5 BUV samples will be made in each block. This
level of replication is generally sufficient to satisfy statistical power requirements for a GLM
approach (see Willis et al. 2003 for a detailed explanation). Statistical power in this sense refers to
the probability that the specified test will reject the null hypothesis when the alternative hypothesis
is likely to be true, i.e. the probability of not committing a Type II error (Sokal & Rohlf 1995).
It is essential for subsequent statistical analysis that replicate samples within blocks are
independent of each other. Replicates therefore must be assigned randomly (or haphazardly if true
spatial randomisation cannot be achieved). If replicates are not independent of each other, the
assumptions underpinning many statistical tests will be violated. A method of selecting random sites
is given in ‘Case study B’.

Habitats
Because species and assemblages of reef fish exhibit distinct associations with both large-and
small-scale habitat features (Cole et al. 2012), it is important to consider habitat distribution when
selecting sites.
As varying taxa and reef fish assemblages exhibit habitat-related preferences (Anderson & Millar
2004; Parsons et al. 2010; Cole et al. 2012), prior understanding of coarse habitat distributions
across the areas to be sampled will facilitate sampling site allocation. It is important that at least the
broad extents of rocky reef and soft sediment habitat across the sampled areas are known.
The standard method is to deploy BUV units within 20–30 m of rocky reef habitat. However, this
approach may not be appropriate for all areas, as camera drops may by necessity be constrained to
rocky reef habitat.
Sometimes, habitat stratification may be required when habitat coverage is not broadly equivalent
between surveyed areas. An example of this is Tapuae Marine Reserve in New Plymouth, where
the majority of the reserve habitat is rocky reef.

Distance between deployments
To avoid pseudoreplication by re-counting the same fish specimens during different deployments, a
minimal distance between deployments should be chosen. For a soaking time of the unit (St) of 45
minutes on the seabed (taking some margin from the 30 minutes of video normally required) and
assuming a current speed (Vc) of 0.2 m.s-1 and a fish speed (Vf) of 0.6 m.s-1 (3 body lengths per
second for fishes of about 200 mm total length), a safe distance (Dist) is c. 360 m. If there are good
reasons to believe current or fish speeds to be different, the following formula can be used for
calculating this safe distance (Cappo et al. 2004):
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Field sampling protocol and deployment procedure guidelines
General comments
The deployment procedure should be discussed at length and a ‘dry run’ undertaken prior to field
sampling proper. The equipment checklist (Table 1) should also be consulted well in advance of
sampling. A minimum of two personnel are required to undertake a BUV survey, but three are
recommended.
As a general rule, sampling sites should be uploaded to a GPS navigation system (fixed or
handheld) prior to sampling. To avoid biases, ensure those sites adjacent to one another are not
going to be surveyed consecutively (for the most part), nor that all sites from one area are to be
surveyed first followed by all sites at another area. It is usually a good idea to randomise the order
in which sampling occurs so the experimenter does not work through an area linearly. If for some
reason, for example a storm, the sampling had to stop, data collected randomly would still be useful
for analysis.

Deployment process (hypothetical example)
To avoid any biases associated with diurnal feeding behaviour, all sampling should be undertaken
in daylight, 1 hour each side of dusk and dawn.
The standard method of BUV deployment is to place the unit within 20 m of rocky reef habitat. This
may not be appropriate for all areas, e.g. Tapuae Marine Reserve (New Plymouth) where the
majority of BUV deployments will require the unit to be placed directly on rocky reef habitat or if the
experimenter has specific objectives. The exact placement protocol should be established in the
sampling design phase.
Considering the hypothetical example presented in ‘Case study B’, there are 15 reserve sites (5 per
block) and 15 non-reserve sites (5 per block) that require sampling by BUV. It is anticipated that the
survey will require approximately 3.5 days to be completed. For the first day of sampling, reserve
sites 3, 8, 12 and 17 and non-reserve sites 19, 23, 29 and 32 will be sampled. These locations will
be uploaded to a GPS unit on the vessel prior to embarking (Figure 25).
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Figure 25. Hypothetical example of reserve (3, 8, 12 and 17) and non-reserve sites (19, 23, 29 and 32) to be
sampled within a given day.

Once near the sampling area, locate the survey site with navigational equipment (GPS) and verify,
via depth sounder, the bottom topography. It may be necessary to move the vessel in and around
the original GPS waypoints to locate the reef/soft sediment transition zone.
Guidelines for the first BUV deployment are:
1. Discuss the plan of action and identify hazards (if any).
2. Locate the site using the depth sounder and, if necessary, anchor the vessel.
3. Check all frame fastenings and re-tighten if required.
4. Turn on the digital video recorder and check record mode.
5. If the camera unit has not been used for an extended period, check the battery life is
sufficient to complete at least 8 hours of continuous recording. Try to decrease as much as
possible opening and closing of housing to avoid leaks.
6. Ensure the digital video camera has sufficient storage capacity to satisfactorily complete the
drop. Note: It is better to ensure recordings are of higher quality rather than sacrificing
quality for greater storage capacity.
7. (where relevant) Place DV camera into housing and use the viewfinder to adjust the focus to
ensure the scale frame is in complete view.
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8. (where relevant) Place a silica pack in the camera housing.
9. Turn on the record function and ensure the camera is recording properly.
10. Place chopped bait within bait container (approximately 200 g or 6 pilchards), fasten to the
container bottom on the BUV frame.
11. (where relevant) Attach drop camera to the housing with lanyard and rubber bands.
12. Attach a pressure buoy to the top hole on the flange of the BUV housing.
The BUV unit will now be ready for deployment.
Follow these steps next:
1. Write the Date+Time, Location, SiteName and DeploymentID on a whiteboard or pad and
place in front of the camera before deployment (Figure 26).
2. Fill in the information about this deployment on the ‘BUV deployment data sheet’ (doccm2618429)3
3. Deploy the BUV unit (Figure 27).
4. Steadily lower the BUV unit to the substratum. Once on the substratum, tie the surface buoy
to the line using a shark clip, ensuring there is enough slack to account for vessel movement
and tide—1.5 times the depth of rope is recommended.
5. If applicable, check, via the drop camera, whether the BUV has landed on suitable
substratum and that macroalgae is not obscuring the field of view. If the BUV unit did not
land on suitable substratum or there are problems with macroalgae blocking the field of
view, gently lift the BUV unit away from the substratum, allow for some vessel and camera
drift, check the depth sounder and LCD monitor for sea-bottom topography and lower to the
substratum again.
6. Once a suitable site has been located, write the GPS coordinates (adjusted) in the ‘BUV
deployment data sheet’ (doccm-2618429), release the drop camera (if relevant) from the
BUV unit with a hard jerk and haul to surface.
7. Untie the surface float and accompanying rope from the vessel bollard and pitch away from
the vessel.
8. Move the vessel away slowly from the site.
9. Over the ensuing 30–35-minute sampling period, additional BUV deployments can be made
if a second system is available.
The BUV unit should always be deployed on the leeward side of the vessel and/or with the
prevailing current to ensure the camera, rope, lanyard, and surface float do not trail under the

3

http://www.doc.govt.nz/documents/science-and-technical/inventory-monitoring/im-toolbox-buvdeployment-data-sheet.pdfhttp://www.doc.govt.nz/documents/science-and-technical/inventorymonitoring/im-toolbox-marine-buv-deployment-data-sheet.pdf
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vessel where they may be prone to snagging or damage. It is important to avoid any hard knocks to
the unit during deployment, as this may distort the pre-set focus.

Deployment duration
For general New Zealand conditions, the standard duration of a sample is 30 minutes once the unit
has settled on the seabed. Shorter deployments are likely to not be long enough to attract the
species of interest in the vicinity while longer deployments are not likely to bring additional
information and will increase the distance required between adjacent deployments. Increased
distance between stations might not always be feasible depending on the configuration of the area
sampled.

Retrieval
1. Approach the surface buoy considering sea state and prevailing currents. It is best to
approach the surface buoy from downwind and/or against the current so that the vessel will
always move away from the BUV unit as opposed to over the top, reducing the chance of
entanglement or damage to the vessel, BUV unit, or both.
2. Retrieve the rope warp with a blunted gaff, and disengage the vessel engine. Haul the BUV
unit to surface taking in slack quickly.
3. Verify that the camera is still recording and fill out the remainder of the ‘BUV deployment
data sheet’ (doccm-2618429) for that particular site.
4. Ensure the BUV unit is securely fastened on the vessel when traveling between sampling
sites.
5. Move onto the next site repeating the above procedures.
6. If the BUV unit requires opening in the field, completely dry the unit with towels before
removing the lens.
7. At the end of the day’s sampling, ensure the BUV unit is washed down with fresh water and
dried.
8. All video data will require immediate backup and storage to computer hard drives.
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Figure 26. Filming site-specific details (on pad)
relating to the BUV drop.
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Figure 27. Immediately prior to deployment. Note:
The BUV coaxial cord (black) plus surface rope
(green) and buoy (not in field of view) are held
together by the surveyor to reduce the chance of
entanglement.

Reviewing video to collect abundance data
A good open-source software for viewing videos is VLC (http://www.videolan.org/.
Edited video data for each site should be of > 30 minutes duration by default. Begin the 30-minute
start point once the BUV unit has settled on the bottom.
Use the MS Excel template to enter your data when starting to review the video (e.g. Figure 28).
The example spreadsheet in Figure 28 starts at 00:02:42 (00 hours, 02 minutes and 42 seconds).
Abundance data are to be collected at 30-second intervals, therefore the first count point is at
00:03:12, second count point is 00:03:42, third count point is 00:04:12 and so on.
Watch the video for each 30-second sequence noting movement of fish in and out of the field of
view, intra- and inter-specific interactions, predator occurrence and any movement (drift) of the BUV
setup.
Count the total number of each fish species in the frame at each count point replicate (n = 60 per
30-min drop for 30-second counts, n = 30 per 30-min drop for 60-second counts). At times fish will
obscure one another. To obtain accurate counts it may be necessary to rewind or fast-forward the
video footage frame by frame to ensure all fish are counted (VLC offers this option: View >
Advanced Controls).
The template spreadsheet automatically gives you MAXcount values for all species. This MAXcount
will be used for subsequent size analysis.
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Figure 28. Spreadsheet depicting analysis of MAXCount for barracuda, scarlet wrasse, blue cod, spotty and
short-tail stingray.
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Figure 29. Counts of blue cod (red numbers) and girdled wrasse (yellow numbers) at two different
times following BUV deployment.
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Managing biases associated with counts
It is likely that any given BUV survey will encounter issues that are out of the control of the
researcher, some of which may bias the data acquisition phase. Biases such as BUV drift and
predator-related effects may impinge on abundance analysis. If camera drift is subtle or not lasting
long (a few seconds) then it is likely to be inconsequential. On the other hand, if BUV drift is
prolonged, then a new deployment is required. The movement of BUV units has been shown to
have a deterrent effect on some species, e.g. snapper (Willis, pers. comm.). To decrease drifting
issues, the BUV system could be weighted down further, but consideration should be given to
factors such as potential impacts on the seabed if the unit continued to drift, the strength of the unit
itself, and also the logistical difficulties associated with handling heavier equipment on a vessel.
Biases associated with predator incursions need to be dealt with on a case-by-case basis. In the
instance of large predators such as seals, sea lions or sharks, there is generally a rapid scatter of
fishes away from the BUV unit. In our experience this is often followed by a fairly rapid (a few
minutes) return of target species to pre-incursion levels. Data acquisition should cease until preincursion levels have stabilised. In the instance of multiple incursions for a given deployment, it may
be prudent to deploy the unit again at a later stage.
If octopus or lobsters are attracted to the bait, there is very little the researcher can immediately do
to eliminate the bias other than redeploying the unit or resuming counts when the bias abates.
Irrespective of the bias, its nature and duration should be noted in detail and attached to the
accompanying data spreadsheet for the corresponding deployment. Reference to any biases that
have occurred should be included in data presentation and reporting sections.

Reviewing video to collect size data
Before beginning size analysis, the investigator should revisit the 30- or 60-second sequence that
corresponds to the MAXcount for each species of interest. The objective is to identify which fish can
be easily sized and which will be more difficult, i.e. those present at the periphery.
Good freeware applications for obtaining length measurements are ImageTool
(http://compdent.uthscsa.edu/dig/itdesc.html) and Fiji/ImageJ (http://fiji.sc/Fiji). Fiji is the same
software as ImageJ but comes with additional add-ons. Other programs are available, with
additional features including a three-point calibration, but are reasonably expensive. Examples of
how to use Fiji are given in Appendix B.
For size analysis using Fiji, a capture program will be required to convert video data (e.g. in AVI
format) into a picture file format (e.g. JPEG). To convert the entire video into frames (single
pictures), several freeware options are available, such as Free Video Converter
(http://www.iwisoft.com/videoconverter/video-converter-features.php), Format Factory
(http://www.formatoz.com/index.html) or VLC http://www.pcfreetime.com/. However, only one or a
few frames are usually necessary per video for each species and hence it is much more convenient
to extract these frames of interest rather than converting the whole video into pictures. This can be
done using VLC (see Appendix B).
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However, only one or a few frames are usually necessary per video for each species and hence it is
much more convenient to extract these frames of interest rather than converting the whole video
into pictures. This can be done using VLC (see Appendix B).

Managing biases when measuring fish lengths
Biases associated with size estimation are typically artefacts of the camera and BUV unit itself.
They relate to lens distortion and length measurements of target fishes that occur at different
heights within the field of view. At the time of writing, we do not have a clear understanding of the
degree of lens distortion (minor, moderate or major) stemming from the use of the semi-fisheye lens
(termed barrel distortion), but this warrants examination so that correction methods can be
developed (Weng et al. 1992). The open-source software Fiji has a plugin to correct for distortion,
developed by Kaynig et al. (2010). It creates a calibration file, specific to any combination of camera
and semi-fisheye lens, from a series of test images. This calibration file can then be applied to all
the images where fishes have to be measured. This method still has to be trialled but offers a
promising solution to measurements using distorted images.
Another option to deal with lens distortion is to undertake calibration deployments using model fish
of known size at different points within the field of view. Obtaining data on fish heights can be done
by placing a secondary camera (e.g. GoPro or equivalent) adjacent to the hinge that links the
bottom scale bar and angled side bar and adding a vertical scale bar at the outer end of the bottom
scale bar. The stereo capability of BUV systems like the one shown in Figure 2 also eliminate the
problem of not being able to do some measurements but at the cost of a much more complex
setup.
In addition, we do not have a clear protocol for estimating the length of fishes that occur at different
heights in the field of view, other than calibrating the measurement tool from the top of the bait
container that sits 100 mm higher than the calibrated base and obtaining measurements when the
fish are either close to the bait container or calibrated scale bar (Willis & Babcock 2000). The issue
of variable heights is generally not a problem for blue cod, which typically sit on the bottom within
the calibrated field of view, but can be an issue for species such as snapper and tarakihi. When it is
difficult to obtain an accurate length estimate, it is recommended to exclude the measurement from
the dataset.

Timing
Consideration of timing of the surveying activity should include:


Any diurnal, seasonal or lunar characteristics and how this may affect surveying (including
whether previous surveys have occurred at a certain time of year/day etc).



What are deemed ‘safe’ hours of operation for the surveying activity (e.g. for allowing
enough time for personnel involved to return safely home/back to base within daylight
hours).
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Safety
Safety is paramount during any survey activity. The safety recommendations below are provided as
general guidance, but it is imperative that the survey leader understands all risks associated with
the activity, always uses caution, and develops a Safety Plan for the survey activity and location
(DOC staff should use RiskManager, and non-Departmental staff should consult WorkSafe New
Zealand’s 4-step risk management4 or their own organisation’s safety plans). Safety Plans should
include resources (e.g. equipment, boats, communication, support, personal protective equipment),
environmental hazards or considerations (e.g. remoteness, surf zones), personnel (experience,
training, physical and mental fitness), weather and mission complexity. Following a thorough safety
briefing, all team members should read and then sign the Safety Plan.
Specifically, the survey must be planned so that:


A minimum of two people make up the survey team



All personnel are operating within the limits of their training and experience



The magnitude and complexity of the survey are relevant for the planned duration of the
survey

Quality control
Quality control measures should be used to ensure that data quality is consistent across surveys
and with previous surveys.


Species identification should be carried out by somebody with expert knowledge.



If there is any uncertainty in the identification process, then a second opinion should be
sought from another experienced individual.
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Appendix A
The following Department of Conservation documents are referred to in this method:
doccm-1163829

MPAMAR metadata—National

doccm-1395189

Baited remote underwater video guidelines

doccm-2638313

Baited underwater video: definition of data fields

doccm-2618429

BUV deployment data sheet

doccm-146272

Standard inventory and monitoring project plan

Appendix B
Size analysis with Fiji/ImageTool and VLC software


The Fiji software (http://fiji.sc/) can be used for size analysis (Figure 30). It is a standalone
program which does not need to be installed; it can run directly from its own folder.



The image(s) that correspond to the MAXcount will need to be imported into the program.
This can be achieved using VLC (http://www.videolan.org/vlc/index.html or
http://www.pcfreetime.com/).
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Figure 30. Fiji main menu.

Exporting frames from VLC (version 2.2.2)


If you do not have VLC on your PC, download and install it.



Open the video file of interest.



Check that Advanced Controls are available: View > Advanced Controls.



Go to the time code of your Maxcount, as based on the results of the analysis you did.



Isolate the frame(s) you are interested in. You can use the tools provided by the Advanced
Control menu to advance frame by frame



Press Snapshot



Note that the folder where the images are saved can be changed, as well as the filename
convention. Go to Tools > Preferences > Video. It makes sense to change the prefix to
reflect the time stamp of the video. To do this, add ‘$T’ (Figure 31).

to save the desired frame (shortcut: SHIFT+S).
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Figure 31. Changing output folder and prefix of snapshots in VLC

Image import


To import image: File > Open.



Check that the displayed image is correct and corresponds to the MAXcounts (Figure 32).
Note: Counts can be re-checked in Fiji using the ‘Point Picker’ plugin.
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Figure 32. Imported image corresponding to the MAXcount for snapper (a single specimen in this case).

Calibration


Calibration only needs to be done once at the beginning of a Fiji session if the same camera
system is used. Calibration should be re-done for every separate day of sampling event or
any time it is suspected that the field of view changed because the camera was moved.



Use the line tool
and draw a line over the length of one black or white mark of the
frame (Figure 33). Alternatively, draw the line across the diameter of the top section of the
bait holder. It can be advantageous to use the bait holder instead of the base bar for scaling
the image because it is slightly higher than the seabed and more likely to be at the same
height than where fishes will be measured. It might sometimes be necessary to use both
scales for calibrations if fishes are seen to be at different heights.
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Figure 33. Calibrating the image.



Go to Analyze > Set Scale and enter the correct values. In this case, both the scale bar
marks and the bait holder have a dimension of 100 mm. Tick the option Global if you want
this scale to be used for the following image you will open during this Fiji session (Figure
34).

Figure 34. Setting the scale. Here the black marking is 100 mm in length. Note that the option Global is ticked
to use this scale for all following images.



Check that your scale is right by making a measurement of another black or white marking,
or top of bait pot if its dimensions are known (see below for procedure).
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Size measurement


Use the line tool
and draw a line over the length of the first fish. Go to Analyze >
Measure or Press CONTROL+M. The results of your measurements will be displayed under
the Length field (Figure 35).

Figure 35. Measuring the length of a snapper. This specimen is 535 mm in total length.



Transfer the length values to your master spreadsheet and then move to the next specimen
(or next image if this was the last specimen to measure on this image).



Sometimes fish specimens might not be straight and it may be necessary to use multiple
lines to produce an acceptable length measurement. Note, however, that this procedure is
likely to produce length results with lower values than for straight fishes.
To do a multiline measurement, right click on
and select Segmented lines
. You
can then do a multiline measurement. Always finish by pressing CONTROL+M to display
your result (Figure 36).
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Figure 36. Multiline measurement of a non-straight specimen.
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